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Warranty Statement 

There are no warranties, express or implied, with respect to the contents of this document, and all information 

provided herein is provided “as is.” Anatomage reserves the right to periodically change the information that is 

contained in this document; however, Anatomage makes no commitment to provide any such changes in a timely 

manner or at all. 

Limitation of Liability 

In no event shall Anatomage or its affiliates be liable to any party for any direct, indirect, special, or consequential 

damages in connection with your use of this document, including, without limitation, loss of business revenue or 

earnings, lost data, damages caused by delays, lost profits, or a failure to realize expected savings, even if 

Anatomage was expressly advised of the possibility of such damages. 

End of Life Statement 

InvivoLight software is dependent on its hardware requirements. The life-cycle is limited only by the availability of 

the required hardware. 

Trademarks 

Anatomage and related marks, images, and symbols are the exclusive properties of, and trademarks of, Anatomage 

Inc. All other brands and marks are the properties of their respective owners. 

Copyright 

Documentation for InvivoLight and the operating software are copyrighted with all rights reserved. Under the 

copyright laws, this documentation may not be reproduced, transmitted, transcribed, or translated into any human 

or computer language in whole or part without the prior written permission of the copyright holder. 

About Anatomage and InvivoLight Software 

This version of InvivoLight was released as an update to the original InvivoLight software from Anatomage, 

Inc. In this document, InvivoLight refers to the latest version of the Anatomage InvivoLight software. To 

learn more about Anatomage, access the Anatomage website (www.Anatomage.com). 

Intended User 

 

InvivoLight is designed to be used by medical and dental professionals who have been appropriately trained 

to use 3D CT imaging devices and read the image data generated by the devices. 

Language 

The original language of this manual is English. Other versions are available. Please contact Anatomage for 

other language versions.  

Caution: Federal law restricts this device to sale by or on the order of medical and dental clinicians. 
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Indications for Use 
InvivoLight is a software application used for the display and 3D visualization of medical image files from 

scanning devices, such as CT, MRI, or 3D Ultrasound. It is intended for use by radiologists, clinicians, 

referring physicians, and other qualified individuals to retrieve, process, render, review, store, print, assist in 

diagnosis and distribute images, utilizing standard PC hardware. Additionally, InvivoLight is a preoperative 

software application used for the simulation and evaluation of dental implants, orthodontic planning, and 

surgical treatments. 

 

This device is not indicated for mammography use. 

 

General Precautions 

  

  

 

Warning: The software provides tools for dental prosthetics creation and design but is dependent on the user to 
determine and use the appropriate parameters. Incorrect parameters may affect the quality of  the final milled products or 
otherwise to surgical delays or complications. 

  

 

Warning: Please ensure all hardware devices with the software are password-protected from unauthorized use and all patient 
information is secure. 



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 4 of 68 UM-INVL-ENG-60E 

 

Table of Contents 
Table of  Contents ................................................................................................................................. 4 

Introduction.......................................................................................................................................... 7 

System Requirements ........................................................................................................................... 8 

Installing InvivoLight ........................................................................................................................... 9 

About the License Type .................................................................................................................................................. 9 

Perpetual Licenses .................................................................................................................................................. 9 

One-year Licenses................................................................................................................................................... 9 

Website Installation Instructions .......................................................................................................................... 9 

InvivoLight Setup Wizard ..................................................................................................................................... 9 

Validating the Installer File ................................................................................................................................. 11 

Feature List.......................................................................................................................................... 12 

Software Layout ................................................................................................................................... 13 

InvivoLight Preferences ...................................................................................................................... 14 

Display Preferences ...................................................................................................................................................... 14 

Volume Rendering Preferences................................................................................................................................... 16 

File Manager Settings ................................................................................................................................................... 17 

Basic Features ..................................................................................................................................... 18 

DICOM & Invivo File Loading with the File Manager .......................................................................................... 18 

Invivo/DICOM File Saving ........................................................................................................................................ 20 

Invivo ..................................................................................................................................................................... 20 

DICOM ................................................................................................................................................................. 20 

Custom Saving Dialog .................................................................................................................................................. 21 

Saving As an Invivo Project File ................................................................................................................................. 21 

Lay Egg .......................................................................................................................................................................... 21 

Export to CD ................................................................................................................................................................ 22 

Send File ......................................................................................................................................................................... 23 

Anatomage Cloud ................................................................................................................................................ 23 

Upload for Service ........................................................................................................................................................ 24 

Case Information Display............................................................................................................................................ 25 

Image Capture to File................................................................................................................................................... 25 

Image Capture to Gallery ............................................................................................................................................ 25 

Image Capture to Clipboard........................................................................................................................................ 26 

Image Navigation ............................................................................................................................... 27 

Slider Scroll .................................................................................................................................................................... 27 



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 5 of 68 UM-INVL-ENG-60E 

 

Zoom In/Out................................................................................................................................................................ 27 

Pan (Shift) ...................................................................................................................................................................... 27 

Free Rotate ..................................................................................................................................................................... 28 

Free Rolling .................................................................................................................................................................... 28 

Increment Rotate .......................................................................................................................................................... 28 

Increment Roll............................................................................................................................................................... 28 

Anatomical Plane Clipping .......................................................................................................................................... 29 

Scroll Slice ...................................................................................................................................................................... 29 

Full Screen Mode................................................................................................................................. 30 

Switching to Full Screen Mode ................................................................................................................................... 30 

The View Tabs: .................................................................................................................................... 31 

ArchSection View Features ................................................................................................................. 31 

ArchSection: Toolbar ................................................................................................................................................... 32 

ArchSection: Control Panel ......................................................................................................................................... 34 

ArchSection: Rendering Window ............................................................................................................................... 36 

ArchSection: Creating A Nerve Pathway ................................................................................................................. 37 

ArchSection: Custom Layouts ................................................................................................................................... 38 

Implant View Features ........................................................................................................................ 39 

Implant: Toolbar ........................................................................................................................................................... 40 

Implant: Control Panel ................................................................................................................................................. 42 

Implant: Rendering Window ....................................................................................................................................... 44 

Implant: View Preset Setup ......................................................................................................................................... 44 

Implant: Model Visibility ............................................................................................................................................. 46 

Implant: 3D Implant Widget ...................................................................................................................................... 46 

Implant: 2D Implant Widget ...................................................................................................................................... 46 

Implant: 3D Implant Planning .................................................................................................................................... 47 

Implant: Pano Implant Planning ................................................................................................................................ 48 

Implant: Bone Graft Simulation ................................................................................................................................. 49 

Implant: Check Sleeves ................................................................................................................................................ 50 

Implant: Settings and Preferences .............................................................................................................................. 51 

Detailed Implant Settings ................................................................................................................................... 52 

Preferred Implants Settings ................................................................................................................................ 52 

Update Implant Library ...................................................................................................................................... 53 

Density Profile Control....................................................................................................................................... 53 

Gallery View Features ......................................................................................................................... 55 

Gallery: Toolbar ............................................................................................................................................................ 56 



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 6 of 68 UM-INVL-ENG-60E 

 

Gallery: Control Panel .................................................................................................................................................. 56 

Gallery: Rendering Window ........................................................................................................................................ 57 

Gallery: Adding Images to the Gallery ...................................................................................................................... 58 

Gallery: 2D Image Options ......................................................................................................................................... 60 

Common How-to Tasks ...................................................................................................................... 61 

How to Trace a Nerve.................................................................................................................................................. 61 

How to Create Reports in Life Size ........................................................................................................................... 62 

InvivoLight6 Software Troubleshooting.............................................................................................. 63 

Keyboard Shortcuts ............................................................................................................................. 65 

Index .................................................................................................................................................... 66 

  



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 7 of 68 UM-INVL-ENG-60E 

 

Introduction 
InvivoLight Imaging Software 

natomage, Inc. is a medical imaging company composed of  
a cross-functional team consisting of  the most elite 
researchers, mathematicians, engineers, software developers, 

business analysts, industry leaders, academic faculty, and dental 
specialists. We believe that InvivoLight software will enable the 
profession to initiate a revolution of  unimaginable scope and 
magnitude. Ultimately, our mission is dedicated to developing simple 
and refined software specially designed for dentists to utilize the 
most advanced cutting edge software and technology to better serve 
their patients. With InvivoLight software, doctors can create 3D 
volume renderings on their own computers, get cross sections, trace 
nerves, place implants, print images, save images, and many more functions. The software is designed to 
reconstruct these 3D volume renderings from DICOM files generated by CBCT, Medical CT, and MRI 
radiography machines. InvivoLight is intended for use as a planning and simulation software in the placement of  
dental implants, orthodontics, and surgical treatment. 

his manual is intended to provide supplementary information to your direct training with the Anatomage 
support team. For correct and safe use, training is available to all InvivoLight users and is highly 
recommended. In this document, InvivoLight refers to the latest version of  the Anatomage InvivoLight 

software. Previously released versions of  this manual are available. For more information on how to access 
previous versions of  the InvivoLight Reference Manual, please contact the Anatomage customer support team at 
(408) 885-1474 or email support@anatomage.com 

 

A 

T 
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System Requirements 
Below are the minimal and recommended system configurations. 

aving an adequate computer system is essential to using InvivoLight efficiently and generating the 
highest quality images possible for enhanced analysis and presentation for your patients and colleagues. 
The most important element is the video card (3D graphics chip or GPU). If  your system does not 

have an appropriate video card, you can purchase and install video cards for desktop computers. 

InvivoLight has minimal system requirements; however, Anatomage recommends the following configurations to 
fully utilize all the features within the InvivoLight Software. The following recommendations have been updated in 
September 2017: 

Summary 
 

Minimum Recommended 

CPU Intel Core i5 2400 
Intel Core i7 4000 series or comparable multi-

core processor 
RAM 4GB 8GB 

GPU / Graphics Card Intel HD 4000 AMD Radeon RX 580 or comparable 

Hard Disk 100 GB 500 GB 

OS Windows 7 64-bit 
Windows 7 64-bit, Windows 8* 64-bit, 

or Windows 10* 64-bit 
 

Mac Users 

 OS Hardware 

Not Compatible Apple OS, Parallels iPad 

Fully Compatible 
Apple Bootcamp (requires a full license of 

Windows) 
MacBook Air, iMac, MacBook Pro (15in), Mac 

Pro 

Note: For optimal visualization, the monitor display scale should not exceed 150 percent. 

Graphics Cards / GPU Details 

Brand Model Series Low-End Options High-End Options 

Intel Intel HD 4000 – Intel Iris Pro Intel HD 4000 Intel Iris Pro 

AMD 
Radeon HD 4600 – 

RX 580 
Radeon RX 550 

Radeon HD 7970 

Radeon RX 580 

Nvidia 
GeForce GT 430 –  

GeForce GTX Titan 
GeForce GTX 1030 

GeForce GTX 1060 
GeForce GTX 1060 Ti 

 

  

H 
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Installing InvivoLight 

About the License Type 

The authorization code provided for activation should be one of  the two license types below. If  the license type is 
not known, please contact the distributor of  the license, which can be either Anatomage or a partner CBCT 
scanner manufacturer that bundles InvivoLight licenses. 

Perpetual Licenses 

• This is a single-use license for one computer. Internet connection is required 
for the initial installation but not during subsequent use of  the software. If  
Internet access is not available, the license can be manually activated by the 
distributor’s tech support. 

 
One-year Licenses 

• This is a single-use license for one computer. This license provides the same 
functionality as for the perpetual version for one year. For license renewals, 
please contact the license distributor’s tech support. 

 
Note: Please ensure each code is entered on the desired computer. Once a code has been activated, you 
must contact the distributor of  the license to transfer the license.  
 
Website Installation Instructions 

1. Go to www.Anatomage.com 

2. Select “Dr. Login.”  

• Contact your license distributor for login information. 

3. Click on the InvivoLight Installer. 

4. Click “Save File.” 

5. Run File. 

 

InvivoLight Setup Wizard 

Before proceeding, please ensure the computer is connected to the Internet.  



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 10 of 68 UM-INVL-ENG-60E 

 

Click Next to continue. 

 

 

Enter the numerical authorization code. If  
you have an alphanumeric license key, click 
Advanced and put in the key in the blank 
provided. 

Click Next to continue. 
 

Installation Preferences: The user can specify the folder for software installation as well as the level of  
functionality with which the software initially opens.  
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Review the End-User License Agreement 
and accept the terms if  desired to proceed 
with the installation. 

 

Click Next to continue. The program proceeds with installation until completed. Click Finish to close the 
wizard. 

 

  

Validating the Installer File 

 
1. Right-click the Installer file and select “Properties” to open the Properties window. 

2. Open the “Digital Signatures” Tab. 

3. Select “Anatomage, Inc.” and press Details. 

4. Verify that the Digital Signature Information is “OK.” 

 

The following pictures are for demonstration purposes only. The name of  the installer and Digital Signature Information is dependent 
on the release version and may change accordingly.  
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Feature List 
An overview of  the various features provided by InvivoLight. 

• Directly Opens DICOM Data from Any CT Machine 

 

• Invivo File Compression 

 

• Section and Multislice View Operations 

 

• Volume Rendering of Scan Data 

 

• Linear, Angular, Circumferential, Area, and Volumetric Measurements* 

 

• Image Capture and Export 

 

• AVI (Movie) Capture and Export 

 

• Implant Treatment Planning 

 

• Restoration and Abutment Visualization 

 

• Bone Density Evaluation 

 

 

 

 

 

 *All measurements are performed with the metric system. 
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Software Layout 
The following is a description of  how InvivoLight is organized by Menu Bar, Toolbar, View Tabs, View Control Panel, and Rendering 
Window. 

 

 

 

 

 

 

 

  
Control Panel 

The Control Panel is the region 
where patient images can be 

manipulated and controlled.  The 
Control Panel is associated with 

a specific View Tab. 
 

Rendering Window 

Rendering Window is the region 
where patient images are 

displayed.  This window can be 
customized within many of  the 

View Tabs by using the Toolbar. 

Toolbar 

Tools can be accessed to 
perform certain 

functions on patient 
images.  Sets of  tools are 
associated with a specific 

View Tab.  

Menu Bar 

The Menu Bar 
contains application 
operations such as 
open, save, close, 
print, capture, etc. 

 

View Tabs 

The View Tabs perform 
specific tasks or look at specific 
subjects of  interest by adjusting 

the Toolbar and View 
Controls 
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InvivoLight Preferences 
This section explains the different options within the Preference window of  InvivoLight. The InvivoLight preferences include options for 
Display settings, Volume Rendering settings, as well as File Manager settings. 

Accessing the InvivoLight Preferences: 

• In the Menu bar of  the InvivoLight, select “File.” 

• Select “Preferences…” from the “File” drop-down. 
 

Display Preferences 

 

GUI Settings 

• Background: Sets the background color for 
the rendering window. 

• Measurement Font Size: Sets the 
measurement font size to a size preset: 
small, medium, or large. 

• Measurement Text Color: Sets the text 
color for measurement notations. 

• Measurement Line Width: Sets the width 
for measurements. 

• Measurement Line Color: Sets the color of  
the measurement lines. 

• Tag Text: Provides an additional label to 
the right-hand corner of  the rendering 
window. 

• Date Format: Current date format for case 
information display. 

• Continuous view: 
o Checked – Switching between view 

presets for volume renderings shows 
intermediate volume positions. 
Unchecked – Switching between 
view presets does not show 
intermediate positions; the volume 
“jumps” to the final position. 

 

• Make text annotations global: When checked, previously placed or new text annotations added to 
any 2D slice view will be visible when scrolling past the slice the measurement was placed on. 

• Cycle 2D distance measurement color: Measurement colors cycle with every measurement that is 
added. 

• Enable multiple distance measurement mode: Distance measurement becomes a toggle on/off  
button for measurement mode. Toggling “on” this mode continuously picks beginning and end 
points for linear measurements with each click after the first measurement has been created until 
toggled “off.” 
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Color Theme:  

• Two color themes are available for the software.  

• The software images in this manual are in Black and White mode, but the overall functions are 
shared between the themes. 

Auto save 2D view setting on application exit 

• This setting determines if  2D view settings made in each of  the applicable tabs are saved 
automatically upon program closure and be reloaded with the next opened case. If  left unselected, 
the user has to manually save the configuration by clicking Save View Settings in the working tab. 
The specific 2D view settings that are saved in each tab are given in the table below: 

 
ArchSection Slice Interval, Cross Section 

Width/Interval/Thickness, Auto R-L, Pano 
Image Type, Pano Ruler Enabled, 
Brightness/Contrast mode, Layout (including 
Axial vs. Cross Series and Print Layout), 
Sharpen Filter, Color Preset, Nerve Diameter, 
and Nerve Visibility 
 

Implant Planning Layout, Restoration Lock, View 
Preset, Brightness/Contrast, Sharpen Filter, 
Volume Clipping, and Remove Crown 
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Volume Rendering Preferences 

 

Volume Rendering View Settings 

• Quality Resolution: Sets the limit for the 
resolution of  the image. This can be set to 
either a user-defined number or set to 
Unlimited. 

• Initial Rendering: Sets the rendering quality 
upon opening InvivoLight. 

• Shaded Slice Sampling Rate: Accepts a 
numerical value that sets the sampling rate 
to improve image quality at the cost of  
performance. 

• Use lower resolution while moving volume: 
Positional changes of  the volume are 
rendered at a low-quality resolution while 
maintaining the quality resolution setting in 
the final position. 

Volume Rendering Range 

• The user can define the range of  
Hounsfield Units that are rendered. This 
cannot be set when “Use automatic H.U. 
range” is checked.  

• Checking “Non-CT modality: use scalar for 
min-max” allows the user to define the 
minimum and maximum scalar units that 
are rendered. 

Material 

• Various properties can be adjusted to change the appearance of  a volume rendering. Ambient, 
Diffuse, and Specular effects can be rendered in different colors. 

• The degree of  Emission and Diffuse can be adjusted with the respective sliders. 

• Shininess is set to a number – higher numbers denote less shininess. 
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File Manager Settings 

File Type-Associated Folder Paths 
Folder paths can be set for each of  the Invivo and DICOM file type options. When one mode is selected, 
the program uses the file paths associated with that file type mode, but the user may still save or open either 
file type at any time. 
 
File Path Preferences for Different Users 
In the situation that there are multiple users on a single computer with InvivoLight installed across multiple 
user accounts, the file paths for all new accounts initially take on the preferences defined by the user 
administrator account. Non-admin accounts may redefine their file path settings, but they will be 
overwritten the next time the settings are changed on a user administrator account. 
 

 

File Paths 

• Anatomage Case Path: Starting the program 
will open a window showing a list of  cases 
within this location. 
o Can also serve as a backup folder for 

all opened cases. 

• Default Open Path: This is the starting 
location for attempting to open a case 
through File → Open in the Menu bar. 

• Default Save Path: This is the starting 
location for saving a case file in InvivoLight. 

Copy Files to Anatomage Case Folder 
Before Open 

• This section allows the user to save a copy 
of  a case that is to be opened in the 
Anatomage Case Folder if  it is in any 
location besides this folder, such as on a 
different location on a network, on a CD-
ROM, or in a different folder on the local 
hard drive. 

DICOM Advanced Settings 

• This option is only available if  the DICOM 
File option is selected. 

• Saving Character Set: If  checked, this sets 
the value for the Specific Character Set 
DICOM tag (0008, 0005). 

  
  
  



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 18 of 68 UM-INVL-ENG-60E 

 

Basic Features 
The following is a detailed explanation of  the various features provided by InvivoLight. 

DICOM & Invivo File Loading with the File Manager 

  

To open a DICOM data set or InvivoLight-associated file type (.inv, .amg, apj), first launch the InvivoLight 
software. The File Manager appears upon startup for loading the scan data. 

 
  

Click the Browse File button to search 
manually for the data to open. For 
opening DICOM data, as shown to the 
right, simply highlight one of  the .dcm 
files and click Open. It does not matter 
which DICOM file is chosen, as 
selecting one opens all the files within the 
data set present in that folder. For 
opening an Invivo file, select it and press 
Open. Invivo files can also be 
compressed and opened. 
 

 

 
The File Manager automatically stores recently viewed case locations. This allows for quicker access to these 
cases. By default, files are saved in the “Anatomage Cases” folder, located in “My Documents.” This location 
can be changed in the Menu Bar → File → Preferences → File Manager. 
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Quickly search through the recent 
cases by typing in the Patient Name 
or Scan Date in the search fields 
(shown right). The selected cases 
can be removed from the Recent 
Case List by selecting the 
Options... button and using the 
additional buttons (shown below). 
These options can completely clear 
the Recent Cases list. 
 
 

 

After closing a case, to reopen another one, click on “File” → “Open”, and the File Manager will appear 
again. 
 
Selecting Options… displays additional options to delete the recent case history or to delete select cases 
from the list. This only modifies the cases that are displayed on the File Manager and does not delete the 
actual files from where they are saved. 
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Invivo/DICOM File Saving 

InvivoLight provides four options for saving and each type 
differs in the size of  the saved file and its compatibility with 
other software. Choosing “File” → “Save As...” for any file 
presents the dialog on the right. Choosing “File” → “Save” 
when a DCM file is open saves an INV in the specified 
location or simply overwrites the same file if  it is already in 
INV file type. 

 
Invivo 

The following work can be saved as an Invivo file 
(.inv).  

• Case Information & Patient 
Orientation 

• Traced Nerves 

• Implants & Implant Measurements 

• Volume Measurements, Landmarks, 
and Annotations 

• Images captured within the Gallery 
 

 
Click “File” → “Save As...,” browse to the 
destination folder, name the file (default is the 
patient’s name), then click Save. 
 
The following save dialog box appears. Select the 
default “Full” option for saving everything 
without losing any information. 
  
DICOM  
When the DICOM file type is chosen, the output 
options are either a single lossless DICOM or a 
multi-file DICOM (with DICOMDIR) 
accompanied with an Invivo workup file 
containing workup data and a folder of  exported 
Gallery images in DCM format.  
 
For single-file DICOMs (Figure 1), the save 
dialog asks for a location to save the files. For 
multi-file DICOMs (Figure 2), create or choose a 
folder to save the slices and DICOMDIR file. 
The DICOMDIR file presents the directory of  
slices to InvivoLight to accelerate the loading 
speed. 
 

 
Figure 1: Single-file DICOM Save Dialog 

The DICOM File Save Option dialog (Figure 3) presents numerous options for saving the file. 
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Compression reduces the size of  the file at the cost of  increased saving and loading speed, “Lossless” 
or “Lossy” determines the quality (amount of  data) of  the file that is saved. Resampling changes the 
resolution by a factor in each orthogonal plane. If  “Save additional series” option is selected, the 
coronal and sagittal DICOM series are also exported along with the default axial series. 
 

 
Figure 2: Multi-file DICOM Save Dialog 

 

 

Figure 3: DICOM File Save Options 

Custom Saving Dialog 

Available for Invivo file saving: By selecting the “Customize” 
option, the custom saving dialog shows up. In the dialog box are 
data compression options. For the main volumetric image, 
“Lossless” or “Lossy” compression options are available. With 
lossless compression, the volume is compressed to about 1/3rd – 
1/4th of  the original size. With the Lossy compression option, the 
file size can be dramatically reduced, but the image is altered. 
Resampling the data greatly reduces its size by combining voxels to 
reduce the overall voxel count. Rescaling the image reduces the 
number of  shades of  gray in the image. Options to selectively 
compress images in the Gallery, the clinical content (such as 
implants and nerve tracings), and the models can be selected. 

 

 
Warning: Saving files in lossy format degrades image quality. 

 

Saving As an Invivo Project File 

Click “File” → “Save As Project...” to save the case as an APJ, Invivo Project file. This file only saves work up 
data. It requires a reference data (.dcm scan data or .inv file) when opening. If  Invivo cannot locate the reference 
data, it prompts to locate the data filepath. Because it is saving only the changes to the original, APJ files save 
much faster than full INV files. 

Lay Egg 

This function creates an executable file containing the 3D volume data from the scan that is currently open as well 
as a 2D Invivo viewer program. This function is designed to allow the sharing of  scan data from an InvivoLight 
user to a non-InvivoLight user on shareable media such as a CD, DVD, or flash drive. Note that some antivirus 
programs may detect the file as a virus due to its executable format. 
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EggViewer: Running this file 
initializes the viewer program and then 
loads the embedded scan data. The 
EggViewer contains some Section, 
ArchSection, and Gallery functionality.  

                

Export to CD 

This function exports the currently opened scan as a compressed or uncompressed DICOM or a full, 
compressed, or customized setting Invivo file. The exported file is placed in the temporary burn location in the 
computer.  
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Send File 

Anatomage Cloud 

To send the case through Anatomage Cloud, the 

software prompts the user to sign in to an Anatomage 

Cloud account. If  no account was previously made, 

click Create Account to get started. Toggle on 

“Remember Me” to retain the username and password 

that is used. Click Forgot Password? to reset the 

password for an existing cloud account if  needed. 

 

After logging in, the user can input the recipient’s name, 
email, message subject, and notes. This information and 
the link to accessing the case is sent to the recipient’s 
email. The recipient can then preview the case through 
the browser viewer or download it for further use.  
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Upload for Service 

To send the case directly to the Anatomodel website for the 
Anatomodel service, input the Anatomodel login when 
prompted. Toggle on “Remember Me” to retain the login 
information, and click Upload to upload the case. If  further 
instructions are required for processing the case, please contact 
the Anatomodel department at 408-885-1474 ext. 5.  

Note: This function cannot be used for uploading Surgical 
Guide cases. To do so, please access the Anatomodel website. 
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Case Information Display 

To display or hide the Case Information for a specific patient, go to the “File” → “Case Info.” Click Anonymize 
then click OK to save the changes. 

  

 

Image Capture to File 

To capture an image of  the active display to file, click “View” → “Capture to File.” Browse to the location to save 
the image, type the name of  the file, choose the file type on the “Save as type” drop-down, and click Save. The file 
can be saved as bmp, jpg, or png format. Jpg is the most popular file format for images, but there is a small 
amount of  color degradation. Bmp preserves the image, but the file size is big. Png is an effective lossless format 
that does not degrade the color. 
 

 

 

 
 

Image Capture to Gallery 

Selecting “Capture To Gallery” or pressing Ctrl + G captures an image of  the rendering window and save it to the 
Image List (see Gallery Tab features for additional information, pg. 55). 
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Image Capture to Clipboard 

Selecting “Capture To Clipboard” captures an image of  the rendering window to the clipboard for pasting in 
other programs 
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Image Navigation 
Below is an explanation showing how to manipulate images in the rendering window with the keyboard and mouse. 

Slider Scroll 

 
 

• Click the mouse cursor over any slider (e.g. axial slice, brightness, etc.) and move it to adjust the image. 

• Click the slider and keep the mouse cursor in the Control Panel before scrolling the mouse wheel forward or 
backward to achieve the image adjustment you like. 

 
 

Zoom In/Out 

• Place the mouse cursor in the center of  the image you want to 
zoom. 

• Hold down the “Control” key + left-button on the mouse. 

• While holding down the buttons indicated above, move the mouse 
up and down on the screen. 

• This shrinks/enlarges the image: Down vertically zooms out. Up 
vertically zooms in. 

 
 
 
 

Pan (Shift) 

• Place the mouse cursor in the center of  the image you want to shift. 

• Hold down the “Shift” key + left-button on the mouse. 

• While holding down the buttons indicated above, move the mouse any direction 
to achieve the desired image displacement. 
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Free Rotate 

Applicable only for 3D images.  
 

• Place the mouse cursor in the center of  the image you want to shift. 
Hold down the left-button on the mouse. 

• While holding down the left-button, move the mouse in any direction 
to achieve the desired rotational position. 

 

 

 

Free Rolling 

Applicable only for 3D images.     
 

• Hold down the “Space” key + left-button on the mouse. 

• While holding down the buttons indicated above, move the mouse up 
and down to rotate the image about a central axis. 

 
 
 

 

Increment Rotate 

Applicable only for 3D images.     
 

• Use the keyboard arrows ←←←← ↑↑↑↑ ↓↓↓↓ →→→→ to rotate the 3D Model 1 degree up, down, right, or left, perpendicular to 
the computer screen. 

 
 
 
 

Increment Roll 

Applicable only for 3D images.     
 

• Hold down the “Control” key and use the keyboard arrows ←←←← →→→→ to rotate the 3D Model 1 degree rolling left 

or right about a central axis. Pressing ←←←← →→→→ without the Control key pressed will roll the image left or right. 

Use ↑↑↑↑ ↓↓↓↓    to roll the image up or down.  
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Anatomical Plane Clipping 

Applicable only for 3D images.  
 

• Place the mouse cursor over the center of  the image, then scroll 
the mouse wheel forward or backward to clip the anatomic plane 
as you like (after enabling clipping in the Control Panel). 

 
 
 
 
 

Scroll Slice 

Use when you would like to move through the series of  sections when 
in the 2D slice views.  

• Place the mouse cursor in the center of  the image then scroll the mouse 
wheel forward or backward to move one section at a time as you advance 
through the data slices. 
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Full Screen Mode 
Below is an explanation pertaining to running the software in full screen mode. 

Switching to Full Screen Mode 

From the software menu, select “View” → “Full Screen.” “Full screen stereo” is only applicable for the stereo 
display system. To return to the normal screen mode, press the “Esc” key on the keyboard. 
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The View Tabs: 

ArchSection View Features 
ArchSection View Tab is a sectional image exploration view. Instead of  conventional X-Y-Z sections, this view allows the user to 
review the image in dentally meaningful perspectives using multiple cross sections, traversing the lengths of  the dental arches. 
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ArchSection: Toolbar 

Shown below are the Toolbar and tools that are loaded with the ArchSection Tab: 

  

 

Reset: Resets the window to the original view. 

 

Create Arch Spline: After selecting this tool, create a new arch spline or edit an existing arch spline. 
Left-click to place nodes along the arch. Right-click or double-click to finish the arch spline. To 
modify an existing arch spline, drag the nodes to the desired positions. To move the arch while 
maintaining its shape, click and drag the central spline.  

 
Arch Spline Ruler: Places ruler along the arch spline for easy reference. 

 

Distance Measurement: After selecting this tool, click two points to mark the desired distance. A 
number in millimeters automatically displays. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of  the 
desired area. Double-click or right-click to end the measurement. A number in millimeters squared 
automatically displays. Click on the measurement and press the “delete” key to delete it. 

 

Polyline Measurement: Select this option and mark any number of  points in the slice view. Right-
click to end the measurement, and the total distance appears.  Clicking on the nodes and moving the 
cursor can modify points. Click on the measurement and press the “delete” key to delete it. 

 

Reorientation: Adjusts the patient orientation and the visible range of  the scan. 

 

Arrow Notation: Allows an arrow to be drawn on the image. 

 

Circle Notation: Allows a circle to be drawn on the image. 

 

Text Notation: Allows text to be written and edited on the image. 

 

H.U. Measurement: Calculates the HU value of  an area within a bounding rectangle, circle, or 
ellipse. The measurements display alongside the shape and can also be repositioned by dragging. 
The information updates when the box is moved or if  the user scrolls. 

 

Rotate Cross Section: Adjusts the patient orientation in the cross sections. 

 

Layout: After clicking on the layout icon, a list of  various layout options appears. Click on the 
desired layout to apply it. A custom layout can be created and loaded. 



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 33 of 68 UM-INVL-ENG-60E 

 

 

Toggle Cursor Visibility: Conceals or displays cursors. 

 

Information Display: Displays or hides case information embedded in the data. 

 

View Sequence: Allows for the creation of  custom camera sequences and AVI file movie 
capturing. Refer to the Volume Render View Sequence (pg. 30) section for additional 
information and description. 

 

  

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 885-1474 or email us at info@anatomage.com 
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ArchSection: Control Panel 

 

Layout: 

• Change Layout adjusts the layout with different 
numbers of  slices and orientations. A custom layout can 
be configured. (See page 38.) 

• Maxillary Arch and Mandibular Arch options allow two 
different arch splines to be created and saved. Switching 
between the two options changes which spline is 
manipulated and used in creating the panoramic and 
cross sections. 

• “Print Out” layout is optimized for printing the image 
on paper. With Print Out layout, the current view can 
be printed on the paper in life-size. First, capture to 
Gallery, then print from Gallery to ensure the image is 
life size. 

Axial Section: 

• Interval: Distance between the subsequent axial 
sections. 

Cross Section: 

• Width: Cross-section width. 

• Interval: Distance between the subsequent cross 
sections. 

• Thickness: Allows for the cumulative thickness of  the 
slices to be viewed in the cross sections. 

• Auto R-L: This allows the cross section to be oriented 
to a consistent R-L orientation on the screen. If  turned 
off, the cross-section orientation is consistent to the 
arch spline. 

Panoramic Image: 

• Slice mode displays a single cross section along the panoramic curve (yellow). This mode is used for 
tracing the nerve. 

• X-ray shows the ray sum (reconstructed x-ray) in the focal trough. 

• Ruler: Displays a ruler on the bottom of  the panoramic image. 

View Control: 

• Brightness and Contrast can be used to adjust the image. 

• The All drop-down allows for brightness/contrast adjustments in different areas independently. 

• Different Color Presets can be used to view the images in color. 

• Sharpening Filter applies the selected sharpening filter from the drop-down menu to the 2D slice 
renderers. 

Nerve Pathway: 

• New Nerve: Starts a new nerve tracing. 

• Modify: Allows editing of  the selected nerve tracing. 

• Visibility: Controls the visibility of  the nerve in the section and X-ray renderers. 

• Nerve Node: Select a specific node for modification. 
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• Diameter: Selects the diameter of  the nerve that has been traced or a specifically selected node. 

• Delete: Deletes the last placed node during the tracing or the entire nerve if  Modify is active. 
 

 Save View Settings 

• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 
section in Preferences (pg. 14) for more information on which settings are saved for this specific tab.  
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ArchSection: Rendering Window 

 
 
Arch Cursor: Notice the green, orange, and brown coordinate indicators. These ArchSection coordinate 
indicators show the spatial location within the ArchSection modeling window. 
. 

• Cross Section Indicator: The green lines give the location of  the cross sections along the arch spline.  

• Axial Slice Indicator: The orange line shows the axial coordinate position within the section.  

• Arch Spline: The brown spline in the center of  the arch spline represents the current position where the arch 
section has moved. 

• Cross Section: Mouse scrolling within any one of  the three sagittal frames advances the slices to the patient’s 
right or left and causes the green coordinate indicator to move anteriorly or posteriorly in the axial and pano 
sections simultaneously. The up and down keys can also be used to scroll through cross sections by page. 

• Axial Section: Mouse scrolling within the axial section advances the sections superiorly or inferiorly and 
causes the red coordinate indicator to move superiorly or inferiorly in the cross or pano sections 
simultaneously. 

• Pano Section: Mouse scrolling within the coronal frame advances the slices buccally or lingually and causes 
the brown coordinate indicator to move buccally or lingually in the axial and cross sections simultaneously.                              
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ArchSection: Creating A Nerve Pathway 

Creating a Nerve Pathway (e.g. Inferior Alveolar by following the mandibular canal to its exit). 

• Click New Nerve. 

• Left-click the mouse to start the nerve. 

• Move the mouse to the next point along the nerve path and left-click again. 

• Click Delete to remove the last-placed node if  it is mispositioned. 

• Repeat this procedure for the entire length of  the nerve. 

• 2.0mm is the default diameter of  the nerve pathway, but the parameter can be adjusted as desired. 

• Press Done to finish. 
 

Editing a Nerve Pathway 

• Click on a nerve tracing to select it. This highlights the nerve in a brighter red color. 

• Click Modify. This reveals all of  the nerve nodes that are visible in each slice in blue. 

• Nodes can be moved by clicking and dragging it across the scan. 

• Set the Nerve Node drop-down menu to “All” or a specific node.  

• If  “All” is selected, the entire nerve tracing’s diameter can be adjusted. 

• If  a single node is selected, it is located in the slices, and its diameter and position may be adjusted 
independently. The nerve node diameter is adjusted in the Diameter drop-down menu.  

 
Deleting a Nerve Pathway 

• The Delete button can be used if  a point was plotted in the wrong spot by deleting the last point added. 

• Once a nerve has been completed and Done has been clicked, the nerve can be deleted by clicking on it and 
pressing the “delete” key on the keyboard or the Delete button. 

 

 

 
  

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of the nerve can lead to surgical 
complications if diagnosis, treatment plans and/or actual treatment is based off  of the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If you notice any inconsistencies or software problems with nerve 
tracing or have further questions or concerns about nerve tracing, please contact Anatomage support at (408) 885-1474 or email 
us at info@anatomage.com 
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ArchSection: Custom Layouts 

A custom layout can be set by going to the Layout tool or Change Layout. Click Set Custom Layout. 

 

Step 1.  

Select whether the axial slice or the panoramic image should be visible. Set the number of  columns and rows of  
cross sections. At least one cross section is always visible. 

Step 2.  

Select whether the main rendering window division is horizontal or vertical. 

Step 3.  

Click and drag the grey dividing borders to adjust the boundaries of  each view. This affects the resulting size 

of  each view. 

Once OK is clicked, the custom layout is applied. If  another layout is chosen subsequently, the custom 

layout can be reloaded by going to the Layout tool or Change Layout and clicking Load Custom Layout. 
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Implant View Features
The Implant View Tab contains the full-featured implant planning module. 
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Implant: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Implant View Tab: 

 

 
Reset: Resets the rendering window to the original view. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume and distance 
appears. Clicking on the point and moving the cursor can modify points. Click on the measurement 
and press the “delete” key to delete it. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle 
between them appears. Clicking on their control points and moving the cursor can modify 
measurements. Click on the measurement and press the “delete” key to delete it.  

 

Add Implant: Select the Tooth ID for the implant, mouse over the implant site, and left-click the 
mouse to place the implant. Note: specific manufacturers measure the implant from different 
points, so a measurement in the software might not be the same as the actual measurement of  the 
specific implant design. 

 
Toggle Move Widget: Toggles the implant orientation widget on and off. 

 

Implant Angle Dialog: Opens a window displaying all the angles between placed implants.If  an 
angle is clicked, the volume is rotated to view the angle, and the relevant implants are highlighted. 

 

Density Profile Control: Adjust the settings for the displayed density profile around planned 
implants. 

 

Treatment Lock: Locks the implants in place so that they are not accidentally moved when 
viewing the 3D images. 

 

Check Sleeves: The program searches for collisions between the sleeves, instruments, and stone 
models. 
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Bone Graft: Simulates a bone graft near the apex of  an implant and displays its volume. 

 

Change Model Visibility: Allows various models to be turned on or off  from view. 

 

Create Summary: Creates an Implant summary of  images that is added to the Gallery. Images 
contain ID (FDI), implant product, diameter, and length information in the lower right-hand corner 
of  the screenshot. The user is also given an option to print a reference chart which lists the implants 
placed (including implant site, manufacturer, product name, diameter and radius) for each arch. 

 

Layout: Toggles the rendering window layout. 

 

Grid: Toggles between two different grid layouts for use in the upper two section frames allowing 
quick assessment of  measurements and spatial location. 

 

Information Display: Displays or hides case information embedded in the data. 

 

Settings: Adjust the tooth system type, clipping preferences, collision and surrounding parameters, 
rendering quality object colors, and implant library settings. 

 
 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 885-1474 or email us at info@anatomage.com 

 

Warning: Any implants and restorations that are incorrectly visualized in Restoration Design Studio may lead to surgical 
complications or treatment delays. If you notice any inconsistencies or software problems with implant or restoration planning or 
have further questions or concerns, please contact Anatomage support at (408) 885-1474 or email us at info@anatomage.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problems with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Anatomage support at (408) 885-1474 
or email us at info@anatomage.com 

 

 



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 42 of 68 UM-INVL-ENG-60E 

 

Implant: Control Panel 

 

Add Implant: 

• Select one or more implants for placement. 

• Maxillary and mandibular parallelism can be enabled. 

• Place each implant in in the 3D volume. 

• Adjust the implant orientation and placement using the 
move widget that appears on the selected implant. 

Planning Layout: 

• 3D Implant: Place and adjust individual implants on 3D 
volume and 2D slices. 

• Pano Implant: Click and drag implants into the panoramic 
image. Selective parallelism can be configured in this view.  

Restoration: 

• Restoration-editing features are disabled in InvivoLight. 

• Lock to Implant: When selected, the implant and 
restoration move as a single unit. 

View Presets: 

• Setup: Opens a dialog where the view presets can be 
configured. 

• Presets: Preset toggles that display the selected features as 
configured in the Setup. 

• Upper/Lower: Toggles the visibility of  the stone models 
if  present. 

View Control: 

• Rendering Types: Different settings allow for better 
visualization of  certain anatomic structures, soft tissue 
profiles, hard tissue, etc. This is achieved by displaying 
specific densities with specific colors. 

• Brightness & Contrast: Can be adjusted for each of  the presets to enhance the image. 

• Visible: Allows the 3D Volume Rendering to be turned on or off  from view. 

• Remove Crown: Only applicable with surgical guide-related modeling service options. 

• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D 
slice renderers. 
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Clipping: 

Click the “Enable Clipping” box to slice the image along the predefined anatomical planes (sagittal, axial, 
coronal, and arch). Scrolling the mouse wheel or moving the slider moves the clipping plane. To switch a view 
to the opposite side, click “Flip.” 

Implant: 

The implant section can be configured to only show specific implants as defined by the user. For more 
information, look at the Preferred Implant settings further in this section. 

• ID: Use the drop-down menu to select an implant to manipulate. The active implant appears 
lighter in color than the others. 

• Manufacturer, Product Name, Diameter, and Length: The default is generic, but the specific 
implant manufacturer, product, diameter, and length can be selected. 

Save View Settings 

Saves the current 2D view settings to be reloaded upon opening any case. See the Display Preferences 
section in Preferences (pg. 14) for more information on which settings are saved for this specific tab.  
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Implant: Rendering Window 

 

Used for more precise control and final detailed touches to implant treatment planning. Use the navigation 
features discussed below to visualize all aspects of  the implant in the 3D volume. For further information on 
implant position and sizing using the implant widgets, please refer to the next section of  the manual.  

Axial Section: Top left window. This section is the view from the top of  the implant. The yellow line passing 
through the axis creates the view seen in the sagittal view. Scrolling the mouse wheel after clicking inside the axial 
window, or clicking and dragging the line changes the cross section seen in the sagittal view as the line rotates 
about the axis of  the implant. Asymmetrical (STL) implants can be rotated about the long axis in this view (see 
the next section). 

2D Section: Middle left window. The A-B line passing through the implant creates the cross-section view that 
appears in the axial view and is set by default to be positioned at the level of  the implant emergence point. 
Scrolling the mouse wheel after clicking inside the sagittal window, or clicking and dragging the line changes the 
cross section seen in the axial view. The implant widget in this view allows for quick resizing of  implant length 
and diameter (see the next section). 

Density Profile: Lower left window when turned on. Displays a real-time visualization of  the volume density 
immediately surrounding the implant. 

Volume Rendering: Right window. This frame allows user to change the implant position and orientation with 
the orientation widget within the 3D volume rendering. 

 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problems with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Anatomage support at (408) 885-1474 
or email us at info@anatomage.com 

Implant: View Preset Setup 

Visibility presets allow for easy switching between set views during implant planning. To configure these settings, 
click on Setup.  
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• Edit Name: Click on any preset to select it. Type the 
new name into the field. 

• Visibility checkboxes hide or show features in the 
rendering window. 

• Implant Profile: Controls the visibility of  the solid 
implant cross section in the 2D renderers. When 
activated, the currently selected implant has a red profile 
and the unselected implants have blue profiles. When 
not activated, the selected implant shows an opaque 
cross section of  the implant, and the unselected 
implants show as blue profiles. 

• Abutment: Controls the visibility of  the abutment 3D model in the volume renderer or the colored 
profile in the 2D slice renderers. 

• Waxup: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. 
Option is only available after they have been added by an Anatomage technician as part of  a surgical 
guide case workup.  

• Long Axis: Displays a colored rod running through the long axis of  the implant in the volume render. 

• Surrounding: Displays the surrounding volume around an implant. The collision zone is determined by 
the allowance defined in the preferences. 

• Trajectory: Displays the simulated trajectory of  the implant during surgical placement. 

• Sleeve: Controls the visibility of  the profiles in the 2D renderers and 3D models on the volume. Option 
is only available if  the mandibular and maxillary models are available as well as after the Check Sleeve 
action has been performed.  

• Nerve: Displays a 3D nerve in the volume render or a cross section of  the nerve in the 2D section 
renderers. 

• Angle: Controls the visibility of  the angle between the long axes of  adjacent implants as well as the 
angles of  the abutment for each implant. 

• Model: Controls the visibility of  the stone models. Varying degrees of  transparency can be obtained 
with the Opacity slider. 

• Restoration: Controls the visibility of  the 3D waxup models in the volume renderer and the colored 
profile in the 2D section renderer. The colored profile of  the selected restoration or restoration 
associated with the selected implant is red while the unselected restorations are pink. Varying degrees of  
transparency can be obtained with the Opacity slider. 

• Volume: Controls the visibility of  the volume render as well as the rendering type. 
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Implant: Model Visibility 

The  Change Model Visibility function opens the 
Model Object Settings dialog.  

• The “Mandible” and “Maxilla” checkboxes control all 
of  the model visibility options (except Profile Only 
and Density) and allow the user to turn off  the set of  
models for each jaw independently. Note: The visibility 
checkboxes in Model Object Settings do not always match the 
checked/unchecked status of  the visibility checkboxes in the 
Control Panel. 

• The Stone Model and Waxups Opacity can be 
adjusted for both jaws. 

 

Implant: 3D Implant Widget

The  3D implant widget is designed to optimize visibility in the 
renderer and provide a high level of  versatility in implant positioning. 
The linear, colored arrows can be dragged to reposition the implant 
transversely. These arrows only appear when the camera perspective is 
close to orthogonal. The implant may also be moved along these 
directions using the keyboard arrow keys. 

• The yellow arrow (not shown) is parallel to the A-B line. 

• The blue arrow is orthogonal to the green and yellow arrows. 

• The green arrow runs through the long axis of  the implant. 

• The rotation circle appears on the same plane as the two arrows that 
are close to orthogonal to each other and to the camera perspective 
and features eight handles for rotation. 

 

Implant: 2D Implant Widget

The 2D implant widget is designed to optimize visibility in the slice 
renderer and provide a high level of  versatility in implant positioning and 
sizing. The implant may also be moved along its long axis or orthogonally 
with the keyboard arrow keys. 

• The rotation circle has eight arrows for implant rotation along the 
same plane as the currently displayed slice. 

• The two red handles can be selected and dragged toward/away from 
the implant to reduce/expand the diameter of  the implant 
sequentially through any available options for that implant model. 

• The two blue handles can be selected and dragged toward/away from 
the implant to reduce/expand the length of  the implant sequentially 
through any available options for that implant model. 

• The implant model itself  can be selected and dragged in any direction 
along the same plane as the currently displayed slice. 

• A rotation circle appears when the product cross section is selected 
that allows for implant rotation about the long axis of  asymmetrical 
(STL) implants in the top left section renderer. Please contact 
Anatomage for an updated list of  asymmetrical (STL) implants. 
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Implant: 3D Implant Planning 
 

• In the Control Panel, click the Add Implant button.  

• The implant ID dialog shows up (image below). 

• Select the implants to be inserted. Press OK, and an implant and its ID appear on the mouse pointer. 

• Drag and drop each implant in 3D view onto the surgical site. (It helps to have the volume rotated so that the 
surgical site is centered.) 

• In axial view, align the yellow line such that the lower cross-section view becomes the view along mesiodistal 
direction. 

• In cross-section view, re-orient and position the implant so that its angle is as desired. 

• In axial view, align the yellow line such that the cross-section view becomes the view along the buccolingual 
direction. 

• In cross-section view, re-orient and position the implant so that its angle is as desired. 

• Review the final implant position in 3D view. 

o To delete an implant, select the desired implant in the 3D view and press the “delete” key on the 
keyboard. The implant is removed. 

 

A similar procedure can be done to add anchor pins to the 3D volume. Select which anchor, and follow similar 
steps for adjusting its position. 
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Implant: Pano Implant Planning 

 

• Select Planning Layout: Pano Implant under 
the Control Panel in the Implant Tab. 

• Rendering window updates to pano view (left). 

• Adjust the ArchSection focal trough such that 
the middle profile passes through the 
dentition.  

• Drag implants to their desired locations and 
adjust their angles. 

• Click to select implants and manipulate them 
in the cross sections. 

• Click the nodes above the implant identification numbers and drag to connect them with other implants 
to create parallel implant groups. Remove the implants from these groups by clicking on the nodes again. 

• Repeat for all desired implants. 

• Select Planning Layout: 3D Implant to exit Pano-Mode and further adjust individual implants. 
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Implant: Bone Graft Simulation 

• Select the implant that requires a bone graft and click the Bone Graft tool . 

• The graft simulation tool appears as an arc that moves along the central axis of  the implant in the cross 
section. 

• Click to place the graft in the desired position. 

• The resulting graft appears in the 2D sections in blue and in the volume rendering in off-white. 

• The volume of  the graft is displayed in the volume rendering. 

• The graft can be deleted by clicking on it to select it and pressing the “delete” key on the keyboard. 
 

  

 

 

 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of  the imaging, 
there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off  scale H.U. The software measurement 
tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the measurement value depends on threshold 
values; thus, user must set proper thresholds to get the best estimate of  the desired structure. The measurements must not be used 
as the sole metric for any treatment. 

   

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or actual 
treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of  all measurement tools. Measurement accuracy depends on the image data and the hardware scanner 
that generated the image data. The measurement cannot be more precise than the resolution of  the image. Software reports the 
value based on user-picked points. Due to the nature of  medical imaging, the boundary is not always well defined. The apparent 
boundary depends on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to 
brightness and contrast. The user must understand the limitation of  the measurement value before applying to the patient. If  you 
notice any inconsistencies or software problems with measurements, or have further questions or concerns about using 
measurement tools correctly, please contact us at (408) 885-1474 or email us at info@anatomage.com 
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Implant: Check Sleeves 

 

The  Check Sleeves function can be performed to determine the position of  where sleeves would be if  a 
surgical guide was produced for implant placement. This function will simulate possible collisions that may occur 
between: 

• Sleeves and other sleeves 

• Sleeves and the instrument 

• Sleeves and the stone model 

• Instrument and the stone model 
Interference: Demonstrated visually by a dark red-colored sphere. These interference indicators are not 
updated in real-time and are only rechecked after each instance that Check Sleeves is performed.  
 

 
Check Sleeve Interference: The user can 
change certain preferences to better simulate 
the actual procedure that will be performed, 
such as sleeve system, instrument, sleeve size, 
and drill. Solution options are to change 
implant planning, change sleeve preferences, 
or to allow a technician to try to resolve the 
interference. 
  

The option to check sleeves automatically appears when attempting to save Anatomage Surgical Guide planning 
files. 
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Implant: Settings and Preferences 

Selecting the Setting tool  opens up a customization window within the Implant Tab: 

 

Tooth ID System: 

Set the ID to either the Universal or FDI(International) standard. 

Clipping Preference: 

Options for which models to include in volume clipping. 

Show Collision Warning: 

Define whether or not to display a proximity warning between implants at an allowed tolerance. 

Rendering Method: 

Choose which rendering method (Default, Performance, and Quality) you would like to use in the Implant Tab. 

Color Control: 

Set the various colors for the abutment, restoration, and collision colors. 

Detailed Implant Settings: 

Adjust default settings for individual implants. See more information below. 

Preferred Implants Settings: 

Used to modify which implants will be displayed in the drop-down menus in the Control Panel. See more 
information in the Preferred Implant Settings section (pg. 52). 

Update Implant Library: 

Check STL implant library update availability and download them directly.   
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Detailed Implant Settings 

In Detailed Implant Settings, the default settings of each placed implants can be set. 

 

 
Clicking once anywhere in 
the region above activates 
drop-down menus for the 
various implant 
characteristics. Options do not 
appear for implants not in the 
preferred list (see below).  

 

Click OK to save these preferences, and the designated implant will be selected automatically when choosing a tooth in 
the Add Single Implant menu. 

 

Preferred Implants Settings 

The user can hide certain implants from populating the lists to simplify the drop-down menus. By default, all 
implant manufacturers and types are selected as “preferred.” To remove an implant, select it in the list on the 
right-hand side and use the left arrow button to remove it from the list.  

 

These settings apply to the drop-
down menu options for Detailed 
Implant Settings as well as in the 
Implant section of  the Control 
Panel. If  there is a case open with 
implants that are not in the 
preferred list, the implant will still 
show up correctly in the renderers 
and the Control Panel. However, 
the specific settings for this 
implant cannot be changed and 
implants of  the same type cannot 
be added. 

Adding implants to the preferred list can be accomplished by selecting the implant manufacturer on the list on the 
left-hand side, selecting the specific product in the middle column, and pushing the right arrow button to add.  

Certain manufacturers are divided into guided and non-guided subsets to indicate compatibility with the 
Anatomage Surgical Guide kits. 
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Update Implant Library 

Due to the size of  STL implants, most implant library updates 
hosted online or within the installer do not contain these implants. 
This function allows the user to select specific STL libraries as 
desired. Available updates for the listed manufacturers are 
indicated in the Update column. Select the desired manufacturers 
and click Update to download the library into the software. 
Restart the software to apply the updates. 

 
 

Density Profile Control 

Select the Density Profile Control tool  to adjust the settings for the Density Profile. 

 

 

Visible: Toggles the visibility between the Density Profile and the 
third cross section. 

H.U.: Shows the bone density in Hounsfield units. 

Bone Density: Shows the density in Misch’s bone density units. 

Thickness: Changes the sampled volume located around the 
implant. 

Apical Space: Changes the sampled volume located at the apex of  
the implant. 

Cell Size: Changes how finely the voxels are sampled and 
displayed in the volume around the implant. 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
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contact us at (408) 885-1474 or email us at info@anatomage.com 

 

Warning: Any implant planning that is performed incorrectly in any aspect including but not limited to implant location, 
orientation, angle, diameter, length, and/or manufacture can lead to surgical complications if diagnosis, treatment plans and/or 
actual treatment is based off of  the implant planning error(s) in question. It is critical for the end user to learn how to use the 
implant treatment planning tools correctly. If  you notice any inconsistencies or software problems with implant planning or have 
further questions or concerns about correct utilization of  implant planning, please contact Anatomage support at (408) 885-1474 
or email us at info@anatomage.com 
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Gallery View Features 
The Gallery View Tab archives images that have been captured from other tabs. Additionally, images can be imported into Invivo or 
exported to a desired filepath. Comments or notes can be added to describe images that have been captured. 
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Gallery: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Gallery View Tab: 

 

 
Crop Image: Crop captured images to save as new images or replace the original. 

 

Gallery: Control Panel 

 

Images: Gives a list of  all captured images.  

• Each of  these images has a “Name” and “Type” which can be 
renamed by double-clicking on the text. 

• Move Up/Down: Moves the selected image up or down on the list. 

• Crop Current: Crop the currently selected image within 
InvivoLight. 

Image Operation 

• All/Selected: Applies operation to all or a subset of  the images from 
the list. 

• Remove: Removes images from the Gallery. 

• Export: Export the images in the Image List to a path specified in 
the dialog box that opens. Local files can be saved as one of  the 
following formats: .jpg, .bmp, or .png. 

Import Images: 

• Select to import images (.jpg, .bmp, .png) from an external source 
into the Gallery Tab. 

• Using this, patient photographs or 2D DICOMS can be imported 
into the InvivoLight software for storage within the Invivo file once 
saved. 

Comments: 

• Text box displays comments about the image displayed in the rendering window. 

• Add or change comments by editing the text in the Comments Box. 

2D Image Options: 

• Controls settings for 2D images. See more information in Gallery: 2D Image Options. 
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Gallery: Rendering Window 

This window allows the viewing of  captured and imported images. The Gallery is particularly useful for creating a 
workup of  a particular case. Remember that the Gallery’s images are only saved if  the file is resaved; otherwise, 
any captured images will be lost. 

 

 
 

Please refer to Image Navigation (pg. 27) for information about controlling 

and adjusting these images. 

 
  



I N V I V O L I G H T 6 . 0
®

 –  P I O N E E R I N G  T H E  N E W  D I M E N S I O N  O F  P A T I E N T  C A R E ™  

ANA003 Rev E. 11 Aug. 2020  Page 58 of 68 UM-INVL-ENG-60E 

 

Gallery: Adding Images to the Gallery 

Capture any single image to the Gallery. A single image within any view can be captured without including 
the other parts of  the rendering window. When the Capture to Gallery function is used, a dialog appears on 
the screen providing the user with options regarding which parts of  the rendering window to capture.  
 
The options provided by each dialog varies according to which InvivoLight tab is currently displayed; the 
following example is the dialog that appears within the ArchSection Tab: 
 

 
Ex. ArchSection Capture to Gallery 

Capture to Gallery Dialog: 

• Whole View – Captures a screenshot of  
the rendering window 

• Axial – Captures the axial slice view and 
no other parts of  the rendering window 

• Pano – Captures the pano view and no 
other parts of  the rendering window 

• Cross Sections – Captures a series of  
slices that are within the rendering 
window 

 
Options within each Select Image to Capture Dialog: 

Note: Some options appear gray (disabled) in the Select Image to Capture dialog. The choices available are 
determined by the specific layout as well as the view tab. 

 

ArchSection  Whole View 

 Axial 

  

 Pano 

 Cross Sections 

Implant  Whole View 

 Main Volume 

 Axial 

 Cross Section 1 

 Cross Section 2 
 

 Density 

 Pano 

 Arch Volume 

 Front Volume 
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Capture to Gallery Dialog: 

 

 

 Name: Image label 
Note: Image name must be unique from any other captured image in 
the Gallery and must not contain any special characters. 
 

 Type: Image type – can be set from the drop-down to 
“Captured” or “Photo.” 

  

 Comments: Additional comments about the image can be 
added in this section. 
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Gallery: 2D Image Options 

The Gallery Tab is compatible with 2D DICOM images and has several features that allow it to handle this image 
format better. 

Opening 2D DICOM 

When instructed to open a 2D DICOM image, InvivoLight automatically enters a mode that disables 
3D functionality. Only the Gallery Tab is available within the software, and the DICOM appears as a 
Gallery image. 
 
If  a 2D DICOM is associated with a 3D volume as a scout image, opening the volume automatically 
imports that scout image into the Gallery Tab. 
 

 
Grayscale Image Options 
 

For grayscale images in the Gallery, the user has the 
option to adjust several settings such as Gray Scale 
Threshold, Brightness, Contrast, and Sharpening.  
 
The updates to these images are saved and always 
reflect the updated settings when the image is 
selected in the Gallery and also after it has been 
saved/exported and then opened/imported back 
into InvivoLight.  
 
 

 

 
Export to DCM/JPG/PNG/TIF/BMP 
 

An image in the Gallery can be exported into any of  
the above formats when using the Export… button. 
When saving individual Gallery images to file, the 
following image formats are available (JPG, PNG, 
BMP).  
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Common How-to Tasks 

How to Trace a Nerve 

• Go to the ArchSection Tab. 

• Make sure the pano is in Slice Mode (not X-ray mode). 

• Adjust focal trough such that the nerve pathway is visible in pano image. 

• Move pointer to the pano image. 

• Review the nerve pathway while using scroll wheel.  

• If  the nerve pathway is not clearly visible, adjust the focal trough. 

• When the nerve pathway is identified through the pano image, press New Nerve in the Control 

Panel. 

• Starting from the mandibular foramen, click point by point. 

• If  the nerve pathway is not clearly visible, use the mouse scroll wheel to find the nerve and continue 

picking. 

• Near the mental foramen, move the mouse to cross-section view. 

• Use the scroll wheel to find the exit of  the nerve. 

• Pick points connecting the nerve exit. 

• Press Done in the Control Panel to finish the nerve. 

 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of  the nerve can lead to surgical 
complications if  diagnosis, treatment plans and/or actual treatment is based off  of  the incorrect tracing. It is critical for 
the end user to learn how to properly perform nerve tracings correctly. If  you notice any inconsistencies or software 
problems with nerve tracing or have further questions or concerns about nerve tracing, please contact Anatomage 
support at (408) 885-1474 or email us at info@anatomage.com 
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How to Create Reports in Life Size 

• Go to ArchSection Tab. 

• Select Reorientation button in the toolbar 

• Adjust upper and lower limit by dragging green lines and then click Reorientation button to exit. 

• Adjust focal trough (arch spline) or re-draw arch spline by the clicking the Create Arch Spline button. 

• Change Layout Mode to “Print Out.” 

• Change to a desired layout using the Change Layout button. 

• Adjust cross-sectional width and interval. 

• Move cursor to set cross section in desired location. 

• In Print Out mode, user cannot zoom the image since it is set to life size. 

• If  desired structure is not visible in cross section, adjust axial cursor or focal trough. 

• Switch pano image to X-ray mode and turn on the ruler. 

• Turn on the Arch Spline Ruler and turn off  arch spline control points. 

• Turn off  the cursor if  necessary by clicking Toggle Cursor Visibility. 

• Go to the View menu and choose “Capture to Gallery” or press Ctrl + G 

• Go to Gallery Tab. 

• See Print Preview in the File menu and print out a test page. 

• To change the format, go to “Print Layout Setup” in the File Menu. 

• To use a personal logo, replace the “printLogo.bmp” file in installation folder. This folder is typically in 

“C:\Program Files\Anatomage\InvivoLight” 

• If  the Print Layout Setup is changed, choose Print Out mode before recapturing the image. Otherwise 

the image could still be in the previous Print Layout Setup. 

 

 

Warning: Any measurement that is incorrect can lead to surgical complications if  diagnosis, treatment plans and/or 
actual treatment is based on the incorrect measurements. It is critical for the end user to learn how to perform 
measurements correctly and employ proper usage of  all measurement tools. Measurement accuracy depends on the 
image data and the hardware scanner that generated the image data. The measurement cannot be more precise than the 
resolution of  the image. Software reports the value based on user-picked points. Due to the nature of  medical imaging, 
the boundary is not always well defined. The apparent boundary depends on the current brightness and contrast setting. 
The boundary may shift as the user makes adjustments to brightness and contrast. The user must understand the 
limitation of  the measurement value before applying to the patient. If  you notice any inconsistencies or software 
problems with measurements, or have further questions or concerns about using measurement tools correctly, please 
contact us at (408) 885-1474 or email us at info@anatomage.com 
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InvivoLight6 Software Troubleshooting 

Category Error Solution 

General Error Message: 

InvivoLight Application has encountered a problem and needs to close. We are sorry 
for the inconvenience. 

 

Click the “Don't Send” button. 
Check if  there are old versions of  optional plug-ins: remove 
them or upgrade them to be compatible with InvivoLight. 
Launch the InvivoLight application again. 

Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Cannot launch InvivoLight Open Task Manager and check if  multiple instances of  
InvivoLight are already running. 
Close other InvivoLight processes. 
Launch the InvivoLight application again. 

Computer failure Launch the InvivoLight application again. 

Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Installation Error Message: 

Server is not Responding 

Check Internet connection. 
If  Internet is connected, try again later. 

Error Message: 

Please run as administrator to activate software 

Run the installer/application as administrator. 

Error Message: 

Failed to verify the license code! 

Check the license code and try again. 

Check Internet connection and try again. 

Error Message: 

Wrong License Code! 

Check the license code and try again. 

Error Message: 

Invalid Authorization code 

Check the license code and try again. 

Error Message: 

Actual size of  the image can't fit to the paper size! 

Change printer setting or create an image with smaller size. 

 

File Operations Error Message: 

Failed to create process. Please close other applications and try again. 

Close all the other applications. 

Launch the InvivoLight application again. 

Error Message: 

Error : Unknown file format! 

Check if  this file is supported by InvivoLight. 

Error Message: 

Not enough memory 

Close all the other applications. 

Launch the InvivoLight application again. 

Error Message: 

Can't create temporary save file! 

Check if  the remaining disk capacity for the temporary 
folder is big enough. 

Error Message: 

Failed to read DICOM file! 

Check if  this file is supported by InvivoLight. 

Error Message: 

Can't read Dicom’s Image Data! 

Check if  this file is supported by InvivoLight. 

Try to open a file but nothing showing up Check if  this file is supported by InvivoLight. 

Error Message: 

Cannot save file! 

Check if  the file is the correct type. 

Check if  the file path is correct and folder is writable. 

Image is distorted Switch to another view and switch back. 
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Warning Message: 

3D reconstruction may not work! 

Check if  the DICOM files are exported correctly. 

 
For all other issues, please contact Anatomage Inc. Customer Support at (408) 885-1474. 
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Keyboard Shortcuts 
The following keyboard shortcuts are available:  

 Hotkey Description 

ArchSection Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Up Arrow/Down Arrow Scrolls through selected slice 

 Delete Deletes the selected 
measurement/notation/nerve 

Implant 0 Changes to Volume preset 

 1 Changes to Implant preset 

 2 Changes to Stone Models preset 

 3 Changes to Restoration preset 

 4 Changes to Restoration2 preset 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Delete Deletes the selected 
measurement/implant/airway 
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Index 
This comprehensive list provides a quick and easy way to find the relevant information that you would like to examine. 

 
Apical Space ................................................................................................................................................................... 53 
Arch Section View Tab ................................................................................................................................................ 31 
Arch Spline ........................................................................................................................................................ 32, 36, 48 
Bone Density ................................................................................................................................................................. 53 
Bone Graft ............................................................................................................................................................... 41, 49 
Brightness & Contrast ............................................................................................................................................ 34, 42 
Case Information .......................................................................................................................................................... 25 
Check Sleeves .......................................................................................................................................................... 40, 50 
Clipping .......................................................................................................................................................................... 29 
Clipping .......................................................................................................................................................................... 43 
Color Presets ........................................................................................................................................................... 34, 42 
Comments ................................................................................................................................................................ 56, 59 
Control Panel .............................................................................................................................................. 13, 34, 42, 56 
Density Profile .................................................................................................................................................. 40, 44, 53 
DICOM .............................................................................................................................................................. 18, 20, 60 
DICOM & Invivo File Loading.................................................................................................................................. 18 
Export Image ................................................................................................................................................................ 60 
Gallery View Tab .......................................................................................................................................................... 55 
Grid ................................................................................................................................................................................. 41 
Image Capture ............................................................................................................................................................... 25 
Implant ..................................................................................................................................................................... 40, 43 
Implant Angles .............................................................................................................................................................. 40 
Implant Summary ......................................................................................................................................................... 41 
Implant Types .......................................................................................................................................................... 43, 52 
Implant View Tab ......................................................................................................................................................... 39 
Import Image ................................................................................................................................................................ 56 
Invivo File Saving ......................................................................................................................................................... 20 
Keyboard Shortcuts ...................................................................................................................................................... 65 
Layout ................................................................................................................................................................ 32, 41, 44 
License types..................................................................................................................................................................... 9 
Life Size .................................................................................................................................................................... 34, 62 
Measurements.......................................................................................................................................................... 32, 40 
Menu Bar ........................................................................................................................................................................ 13 
Misch’s bone density units ........................................................................................................................................... 53 
Mouse Navigation Tools ........................................................................................................................... 27, 36, 44, 46 
Move Widget ................................................................................................................................................................. 40 
Nerve ..................................................................................................................................................... 34, 37, 38, 45, 61 
Panoramics ............................................................................................................................................................... 36, 48 
Patient Info ........................................................................................................................................................ 32, 33, 41 
Patient Orientation ....................................................................................................................................................... 34 
Rendering Window ....................................................................................................................................................... 13 
Reset Zoom ............................................................................................................................................................. 32, 40 
Software Layout ............................................................................................................................................................ 13 
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Stone Model ................................................................................................................................................................... 46 
Toolbar ........................................................................................................................................................ 13, 32, 40, 56 
View Sequence ............................................................................................................................................................ 33 
View Settings ................................................................................................................................................................. 15 
View Tabs ...................................................................................................................................................................... 13 
Waxups ..................................................................................................................................................................... 45, 46 
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